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Thank you for choosing 
 
 
 

We appreciate your business, and we want your experience using this software to be both 
pleasant and productive. 

Getting Started: 

Installing the software 
 

This software is designed to be self-installing. However, if your computer has CD auto-start 
turned off, the software will not be installed automatically. Here’s how to install it manually in 
five easy steps: 

 
 Insert the Essential Forms CD into your computer's CD drive. 
 Right-click the Windows icon and choose File Explorer (Windows 8 or later) or Left-click 

the Start button and choose Computer (Windows 7 or earlier) 
 Double-click the icon for the Essential Forms CD. 
 Double-click the icon titled Update or Update.exe. 
 Follow the on-screen instructions to complete the installation. 

To start the software: 

[Windows 8 or later] Right-click Start | Search | [and type] Essential Forms 

[Windows 7 or earler] Left-click Start | All Programs | CEB Essential Forms | Essential 
Forms 

 

The Three Tabs-What They Do 
 

When you first start Essential Forms you’ll see four folder tabs near the top of your screen. The 
first three are called Client Information, Forms Library, and Opened Forms and they are the 
key to using this software. They look like this: 

 

  



-4-  

 
  Client Information tab: 

 

This is where you will store information about each client, and where the completed forms 
are saved for each matter/case. The organization follows the standard Windows® files & 
folders format and looks like this: 

 

  
 

 Forms Library tab: 
 

This tab is where all of the blank fillable forms are stored. This includes Judicial Council 
forms and any local county forms to which you subscribe. Here is where you make your 
selection to create new forms for your client. 

 
 Opened Forms tab: 

 

This is the “workspace” where you will find every form that you currently have open for a 
client/matter. At the bottom of this screen, there will be a tab for each open form. To view 
that form you simply click on that tab. 
 

The Basics: 

Adding a New Client 
 

In most cases, you will be filling out more than one form for a client, so it is a good idea to enter 
reusable information (client name, address, etc.) just once into the client profile database 
contained in the Client Information tab. When you open a new form, the information that you’ve 
entered into the client database will automatically fill into each form that you open. Here’s how: 

 
 Click on the Client Information tab, 

 Click on the New Client  icon on the tool bar, or 
 Select File|New Client on the Menu Bar. A screen called the Client Database Assistant 

will appear, which  looks like this: 
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 Fill in the Client Name and the Matter Name. The matter name can be a case type such 
as “Probate” or “Dissolution”, or a case number, or anything else that will help you 
distinguish it from other matters for that client. The default name is “New Matter”, which 
will be used if nothing else is entered. 

 
 Click the OK button, and you will see a dialog box which asks you to Select Filing Court. 

From the pull-down list, select one of the courts you have previously entered and click the 
“Use this court” button. If you need to add another court, click the “Add/Edit stored 
courts” button. (see screen below) 

 

 
 

 Next you will see the Select Filing Attorney screen. Again from the pull-down list, select 
one of the attorney names you have previously entered and click the “Use this 
attorney” button. If you need to add another attorney, click the “Add/Edit stored 
attorneys” button. (see screen below) 

 

 
 

 Click the OK button, and your new client folder will appear on the left-hand side of the 
Client Information screen. 

 
 To see all the matters for this client, click on the right arrow   to the left of the client’s 

name. This will expand the folder as can be seen below: 
 

 

 
  



-6-  

 
 

TIP When you see a right arrow  next to a folder or icon, this means that 
the folder has something in it. Clicking on the arrow  will open and expand 
the folder allowing you to view the contents. A down arrow  indicates that 
the folder is already open and the contents are displayed. By clicking on the 
down arrow  you can collapse and close the folder. 
 

 Now that you’ve created a client, click on the Matter folder   icon and the Client Profile 
data-entry screen displays on the right-hand side of the window. Here is where you enter 
the appropriate client information, which will be inserted automatically into any new forms 
you fill out for this client. 

 
 Notice that the data-entry screen has several tabs located at the bottom of the screen, as 

shown below. We recommend always completing the General tab and then filling the 
other data-entry tabs that are appropriate to your case. 
 

 

 
 
 

TIP Be sure to complete the information in all of the data-entry tabs that relate to 
your matter. It is to your advantage to completely fill in the fields in the database. 
Once you have done so, you will not have to repeat any of this information when 
you   create a form for your client. You can change or add information in these 
tabs at any  time. 

 

 You can save the client profile by clicking either the Save  icon, or by clicking 
Save Changes from the Edit Menu. Any time later you can create additional new 
matters by selecting the client and then clicking on New Matter from the File menu. 
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How to Select & Open a Blank Form 
 

After you have added a new client and created a client profile you will want to select and 
open a blank form to work on. Here’s how: 

 
 Click on the Forms Library tab. 
 On the left side of the screen under a tab called Standard, you will find a series of Form 

Groups. These are blank forms, arranged alphabetically in groups designated by the Judicial 
Council. 

 
 Scroll down to the form group you are interested in and click on the folder. On the right side 

of the screen will be displayed all of the forms contained in that group. Here is an example of 
how the screen looks. 

 
 

 
 
 

 Select the form you want by clicking on the form name with your left mouse button. 
 

 To open the form either double-click the form name, hit Enter on your keyboard, or use 
the Open Selected Forms      icon. The view on your screen will automatically switch 
to the Opened Forms tab screen and your form will now be displayed for you to begin 
filling. 

 
 

TIP You can select and open multiple forms at once by using any of the following 
Windows™ blocking techniques: 
 

 Hold down the <Ctrl> key and left-click your mouse on the forms you 
want to open, in any order you wish. 

 To select a range of forms, click on the form at the top of the range, 
and then hold the <Shift> key and click on the form at the bottom of the 
range. 

 To select all of the forms in a group simply click on any form in the 
group and then hold down the <Ctrl> key and the <A> key. 

 
To open the forms you have selected after using any of these techniques, simply 
click on the Open Selected Forms   icon. 
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Searching for a Specific Blank Form 
 

Judicial Council Forms can be difficult to find because they are not always categorized in 
intuitive form groups. Here’s how to find them. 

 Click on the Forms Library tab. 

 Click on the binoculars    icon in the toolbar, or use the Find command from the File 
menu. This will open a window called Form Finder, as shown below. 

 Check the Form Name or Form Number box and enter the word or number you want to 
search for, and then click the Search button: 

 

 
 

TIP  When you first open this window, open it to maximum size. That way you’ll be 
able to read the full names on the forms. The easiest way to search is to type just one 
unique word from the form name. That way you will always find a list of forms to 
choose from. 

 
 Select the form(s) you want to view and click on the Open/View button on the right side of 

the window. This is illustrated below: 
 

 
 
 

TIP Printing a listing of the forms in a group is easy. In the Forms Library tab, the 
first index entry in the Standard folder is called Form Lists. Here you’ll find listings of 
all Judicial Council Forms and any local county forms to which you subscribe. Just 
double-click to open any of these lists to view and print. 
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Filling in Blank Forms 
 
1. Click the Client Information tab. 
2. Scroll down to the client you want, then click on the  sign next to the Client  icon. This 

will expand and display all the Matter folders for that client. 

3. Click the appropriate Matter folder    icon for that client. This tells the program which 
client/matter data will be used to populate the form(s), and what folder the completed form(s) 
will be saved in. 

4. Select the blank form you want to work on for this matter. 
 Click the Forms Library tab. 
 Select the desired Form Group from the list. 
 Double-click on the Form Name/Number from those displayed on the right side of the 

screen. 
 The view will automatically switch to the Opened Forms screen with the selected form 

displayed. Notice that the data from the client/matter profile has been automatically 
inserted into the form. 

5. Fill out the remaining fields on the form. If this is a multiple-page form, the page number will 
be indicated at the lower right-hand side of the screen, as shown below. 

 
 

TIP You can move from field to field by using your “tab” key, or simply place your 
cursor directly in any field and left-click. 

 
6. To print a form, simply click the Print  button on the tool bar, or you can click Print 

form on the File menu. 
 

7. Save the completed form by clicking the Save Form  button on the tool bar, or select Save 
form from the File Menu. (If desired, you may enter a descriptive comment for the form to be 
saved. If you do so, you will notice that a “musical note” icon will appear next to the form 
name in the Matter folder. This indicates that there is a note associated with the form). 

 
 

TIP  You can open, create and/or edit multiple forms at once for the same 
client/matter without having to close any other form. The bottom of the screen has a 
separate tab for each opened form. (see illustration below). Simply click on a tab to 
move between the forms. This feature allows you to view and copy data from one 
form to another. 
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Finding Saved Forms 
 

Once you have completed and saved a form for a client/matter you can recall it to the screen 
for editing or printing. Here’s how: 

 
 Select the Client Information tab. 

 
 Scroll down to the client name you are looking for, and then click on the arrow   next 

to the Client  icon. This will expand and display the various matter folders for that 
client. 

 
 Now click the arrow    next to the matter folder you want. This opens up that matter 

folder and displays all of the saved forms for that matter, as illustrated on the next page. 
Note that it also shows you the date and time that each form was last saved.
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 Double-click on the saved form you want to work on and it will be displayed in the 
Opened Forms tab. You may now edit the form if desired. Don’t forget to save the 
form if you make any changes! 

 
 

TIP  The program may display a warning screen (as shown below) asking you if you 
would like to overwrite your saved form with the current database information. Unless 
you have recently made changes to your database information, or if you are not sure, 
you should click on the “No, keep saved data” button. If you click on the “Yes” button it 
will overwrite any fields in the saved form with data from the client/matter database, 
including any database fields that may have been left blank. 

 
 

 
 
Renaming Clients, Matters, and Saved Forms 
 

From time to time, you may need to edit or rename a Client or Matter folder or a Saved Form. Here’s 
the procedure to rename: 

 

 Using the right mouse button, click the Client icon   , the Matter folder  , or the Saved 
Form      icon itself.
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 This will bring up a pull-down menu. 
 Click Rename at the bottom of this menu, as shown below: 

 

 
 

 The selected client, matter, or saved form name field will now become active 
(highlighted), so just start typing the desired name. Click on either the folder or matter 
icon itself, or hit the Enter key on your keyboard, to save your changes. 

 

 

Using Our Essential Features: 

Configuration Settings 
 

You can customize many of the default settings and operations of the special features 
described in this section. Here’s how to change these settings. 

 Select Configure, then Preferences  from the Menu bar. 
 A window called Configure user preferences will be displayed. Click on  any of the 

twelve tabs and adjust the settings to your preference, as illustrated on the next page. 
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TIP When you have adjusted any setting(s) as desired, you can save the new 
setting(s) by clicking the “OK” button in the upper right corner of the Configure user 
preferences screen.  You may restore the program to using its original default 
settings by clicking the “Default Settings” button, as shown above. 

 
 
Adding & Editing Firm Data 
 

If you elect to use this feature, the Firm database is designed so that you enter firm information, 
such as its name and address, and/or the attorneys’ names and bar numbers, only once. This 
information then will be added automatically when new clients and matters/cases are created. 
Please note that this information will NOT overwrite any data already stored for any existing 
clients and matters. If you need to edit the Firm database or add additional attorneys, here is the 
procedure: 

 Select Configure and Firm Data from the Menu bar. 

 You will now see a window called Client Database Assistant-Edit Firm Data. 
Click on the Law Firm tab inside the window. 

 Check the Use firm data when adding new clients/matters to the database 
checkbox in order to make the Client Database Assistant window active, which 
then allows you to enter information for your law firm.  

 Just add your firm information, or select your firm from the list, make whatever 
changes you desire and click on the Save Changes button at the bottom.  If you want 
to add another law firm to this list, simply click the New button, fill in the appropriate 
information and save your data. You may also delete any law firms from this list by 
highlighting their entry and clicking on the Delete button: 
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 Note that if you want to use the firm data for an existing client, you can do so by clicking 
on the Import Firm Data button inside the window. You will see a screen showing your 
list of clients, from which you select the one containing the firm data you want to import. 
Don’t forget to click on the Save Changes button after you have finished. 

 If, after viewing the data, you determine no changes are necessary, simply click on the 
Cancel Changes button. 

 You can also edit or add attorneys to this database. Select the tab labeled Filing 
attorney, then choose the attorney that you wish to edit, and make whatever changes 
you desire. Don’t forget to click on the Save Changes when you are finished. If you 
want to add another attorney to this list, simply click the New button, fill in the 
appropriate information and save your data. You may also delete any attorneys from 
this list by highlighting their entry and clicking on the Delete button: 
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Adding & Editing Court Data 
 

If you elect to use this feature, the Court database is designed so that you enter information 
about each court, such as its name and address, only once. Then when you add new clients and 
matters/cases, you simply select the court the matter will be filed in and the court data will 
automatically be filled into the Client matter/case database. If you need to edit the Court database 
or add additional courts, here is the procedure: 

 Select Configure and Court Data from the Menu bar. 

 You will now see a window called Edit Stored Courts. If you need to change some of 
the existing information, simply select that court in the list of stored courts and change 
the appropriate information in the Court description fields. When finished, click on the 
Save Changes button. 
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 You can also add new courts to this database by simply clicking on the 
Add New Court button and filling in the Court description fields. 

 If you no longer need to use a specific court, you can delete it from the Court list by highlighting it, 
and then clicking on the Delete This Court button.  
 
Shrink-to-Fit 
 

As you edit your forms, you will probably notice that sometimes there is not enough space in a 
field to enter all of the data. Our Shrink-to-Fit feature will automatically reduce the size of your 
font as you type so you can fit more text in the field. The field starts with a 12-point font by default. 
When the cursor reaches the end of the field, the font will change to 10-point, and then to 8-point 
if necessary. We don’t shrink the font any smaller than that to keep it readable. The Shrink-to-Fit 
feature is set to “Always” by default so that its operation is automatic. If you wish to change this, 
see below: 

 
 

TIP You may adjust this feature’s operation by going to the top menu bar, selecting 
“Configure”/ “Preferences”   . Click on the “Data Fields” tab and towards the 
bottom of the page and select the choice you want. Here is how each choice operates. 
Always: Shrinks-to-fit automatically as you type. This is the default value. 
Warn: Displays a dialog box when a field has been filled, offering shrink-to-fit options. 
Never: Disables Shrink-to-Fit (however, font size may still be manually adjusted). 
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In addition to using the “Shrink-to-fit” feature, you might want to try other fonts that have different 
spacing patterns to allow you to squeeze more text into a field. Here’s how to change the font 
for that field: 

 
 Click in the field with your right mouse button and select Attributes from the menu. This 

will bring up a window called “Change Field Attributes”. Here is where you can change or 
reset the font, font size, and other attributes for that field. Make your changes and click 
on the OK button. This change will be for that field only and will not affect any other field 
on the form. An example is shown below. 

 
 

 
 
 
Adding a New Field 
 

Often, even if you use the Shrink-to-Fit feature, the field sizes on Judicial Council- and court-
designed forms are still not large enough for your data. Or maybe there is no existing field where 
you wish to put your information. The answer is to add a new field. This added field can be any 
size and can be placed in any location you want. Here’s how to add a field: 

 Click on the Edit menu at the top, then select Add User Field; or 

 Click the Add User Field     button on your tool bar. 
 Either method will make your cursor active. Move the cursor to where you want to create 

a new field. 
 Now click and hold down the left mouse button while you drag your mouse right (or left) 

and then down (or up) to draw a rectangular text field. Release the left mouse button 
when this field occupies the size and position you want. (Note that it is possible to add a 
field by just using this step without using any of the first two methods mentioned above). 

 Click in the new field and begin typing. 
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 TIP You can move, re-size, delete, or change all of the characteristics of this 
field by simply clicking on the new field with your right mouse button to get the 
properties menu. Here is what that menu looks like: 

 
 

 
 

 
 
Creating Custom Form Folders 
 

Essential Forms installs a Standard folder containing the entire set of Judicial Council forms, 
any local county Superior Court forms you subscribe to, and complementary Non-Judicial 
Council forms. The Custom Form Folders feature allows you to: 

 Quickly find and open your most commonly used forms by creating folders of blank forms 
in groups that make sense to you. This will allow you to store the forms you need on a 
regular basis in one place. You can create as many custom folders as you like. 

 Using standard Windows drag and drop controls and edit commands, forms can be 
copied to, moved among, arranged in, or deleted from your folders. 

 
HERE’S HOW: 
 Click on the Forms Library tab at the top of your screen. 

 On the menu bar select File|New Folder, or click on the New Folder   button on the 
tool bar. 

 
 Type in the name that you want to call your custom folder. We recommend you use short 

names such as “Probate” or “Disso”. 
 

 Press the Enter key to create your new tab. The new folder will appear to the right of the 
Standard tab as shown below. You are now ready to start choosing the forms you will 
put into your new folder. 
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 Click on the tab labeled Standard, which contains blank copies of every form, including 
any local county forms to which you subscribe. Select the appropriate form group. The 
names and numbers of the forms in that group will now be displayed on the right side of 
the screen. 

 
 Select the form you want to copy and then click the Copy Selection to  

Another Folder      icon from the toolbar. This will bring up a dialog box enabling 
you to choose which folder to copy the form into, as shown below: 

 

 

 
 

 Select a folder and click OK.  A copy of the form will be placed in the selected 
folder. 

 
 If you prefer, you can use the copy and paste functions from the Edit 

menu to accomplish this task; or 
 

 Another technique is to drag any form from the forms list (click and hold down your 
left mouse button) and drop that form into your new custom folder (by releasing the 
mouse button). Repeat this for every form you want in your new folder. 

 
 

TIP By using any of the standard Windows file selection techniques, you can 
copy multiple forms at once to the new folder. 

 
 
Adding Your Own Notes 
 

Sometimes you’ll want to attach notes or instructions to a form. You can do so for an entire form 
or for specific sections of the form. You can create three different types of notes, depending on 
what you want to accomplish. 
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1. Client Notes, Matter Notes, and Form Notes:  Use this technique when you want to 
record a note that can be seen when you select a client, matter, or saved form in the Client 
Information screen. Here’s how you do it. 

 
 Click on the Client Information tab. 
 Click on the client, matter, or saved form name or the icon next to the name. 
 This will display the Client Notes, Matter Notes, or Form Notes window on the right 

side of the screen shown below (to display the Matter Notes, click the Notes tab at 
the bottom after selecting the desired matter): 

 
 

 
 
 

 To create a new note, click on the Add Notes icon       in the upper left corner of the 
Client/Matter/Form Notes screen. This will imprint the date (and also the logon user ID 
if you are using the program on a network). Now just type in your note to the right of the 
ruler line. 

 If you want to edit a previous note, click on the Edit Notes  icon. 
 

TIP When you save a form for the first time, or select Save New when saving a 
previously saved form, Essential Forms will display a Save Form window.  This 
window contains a Comment box in which you can type a note before saving the 
form, as shown below.  This comment will display in the “Form Notes” window 
discussed above, and can be edited there.  A form containing such a note will 
display on the Client Information screen with a musical note mark:  
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2.  Open Form Notes: Use this option when the note or instruction applies to the entire form. 
 
 With the form open on the Opened Forms tab, select Form Notes from the View 

menu, or 
 Click on the Form Notes  button located on the tool bar. This will bring up a 

window into which you add your notes or instructions.   
 When you have finished typing your note, click the red X in the upper right-hand 

corner of the form notes window to save the note and close the window. 
 

TIP The Form Notes button will change from black  to blue  to indicate the 
presence of a note for that form. 

 

3. Note Marks: Use this option when you want to leave a visual cue on the form with an 
attached note. These note marks appear onscreen when you view the form, but do not 
appear on a printed copy of the form. 

 
 With the form open on the Opened Forms tab, select Add Note Mark from the Edit 

menu, or 

 Click the Add Note Mark  button on the toolbar. This will make your cursor 
active.  Move the cursor to the location where you want to place your note. 

 Click and hold your right mouse button down and drag the mouse right (or left) and 
down (or up). You will see a dotted rectangle appear between the point where you 
started and the point your mouse is currently at.  Release the mouse button and a 
stylized red oval will appear at that location. 

 
 Put your cursor inside the circle’s boundary and click with your right mouse button. 

This will give you several menu choices for that note. Click “Edit Note” to type your 
note, or any of the other choices as desired.  Whenever you hover your mouse within 
the circle, the text of your note will pop up on a yellow background, as shown here: 

 

 
 

 
Using the Automatic Calculation Feature 
 

There are many court forms which require you to perform mathematical calculations and type 
the results on the form. Essential Forms will automatically perform these calculations and enter 
the totals in the appropriate fields by default. 
 

TIP  If you would like to modify these totals manually, for example by deleting zeros, 
you will need to disable this feature, as follows: 

 

 Click on Configure and select Preferences    from the menu bar at the top of the page. 

 This will bring up the Configure User Preferences screen, which has a number of tabs. 
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Click on the tab called Data Fields. 
 Toward the bottom of this tab is a checkbox labeled “Perform Automatic Calculations”. Simply 

uncheck this box and click OK to disable this feature, as shown below: 
 

 
 
 Even with this feature disabled, you can still force the program to calculate totals by clicking 

on the Edit menu from the toolbar and then selecting Calculate, or clicking the Calculate 
button on the toolbar.   

 
 
Configuring Decimals 
 

When calculating monetary data, Essential Forms uses whole-dollar values by default.  For 
example, one hundred twenty dollars would appear as “$120”.  Any calculations performed will 
be rounded to the nearest whole dollar (for example, 100 dollars divided by three would appear 
as “$33”).  If you need monetary data displayed using both dollars and cents (e.g., $33.33), you 
can configure the program to automatically do so by following these steps: 
 
 Click on Configure and select Preferences    from the menu bar at the top of the page. 

 
 This will bring up the Configure User Preferences screen, which has a number of tabs. 

Click on the tab called Data Fields. 
 

 At the bottom of this tab is a checkbox labeled “Use decimal values in numeric fields”. Simply 
check this box and click OK, as shown in the illustration above. 
 

 The program will automatically insert the decimal point in numeric fields as you type. 

Other Tips & Techniques: 

Creating Form Templates 
 

If you use forms where most of the data remains the same from client to client you can speed 
up the process of filling in these forms by creating form templates. Once you have created a 
form template with the pre-filled data, you simply can copy that template to another client’s 
folder and all of the data from that client’s database will also flow into the form. Here’s an 
example of how to create and use form templates: 
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1. Create a new Client folder and name it “FORM TEMPLATES” to distinguish it from your 

real clients. You may also want to set up several “Matter” sub-folders for different types of 
cases, as shown in the illustration below.  Fill in the client/matter profiles with your firm 
data and any other information that will tend to remain the same from case to case. 

 
2. Select the appropriate “Matter” folder and then click on the Forms Library tab. Select and 

open up as many new forms as you would like.  Then click on the Opened Forms tab. 
 

3. Now fill in only the template data that you want to carry over to every client, and once you 
have completed this task, be sure to save the forms. 

 
4. Click on the Client Information tab and look for your “FORM TEMPLATES” folder. 

Here is an example of how it might appear. 
 

 

 
 

Now you are ready to use these pre-filled Form Templates in your client’s matters. 
 
 
Using Form Templates 
 

Once you have created a Form Template folder you may want to use one or a set of its forms 
in a client’s matter. Any form templates you copy into a client’s matter folder will automatically 
fill in with the data from that client’s matter. There are several ways to do this: 

 
1. From your “Form Templates” folder select the form that you want to copy to a client’s 

matter folder. 
 

2. Select Copy from the Edit Menu at the top, as shown on the next page: 
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3. Now scroll to the client you want, open it, and click on the matter folder where the copy 
will be placed. 

 
4. Click on the Edit Menu again and select Paste. This will place a copy of that template 

form into the selected client/matter folder. Now you can double-click on that form, to 
open it, and the form will now reflect the client/matter database information and all of 
your pre-filled template data. Add any other information you want to the form and save 
it. 

 
 

TIP  You can also accomplish the same result by using these other 
methods: 
 
 Use Windows copy (Ctrl+C) and paste (Ctrl+V) functions; or  

 
 Use the Windows drag-and-drop function to simply drag a form from 

your Form Template folder and drop it into the appropriate client’s 
matter folder. 

 
Exporting Client Matters & Saved Forms 
 

If you want to work on a client’s matter at another location or computer, you can do this by 
exporting it (including any saved forms that have been created for that matter) to portable media 
such as a USB thumb drive or  CD, and then importing it into a copy of Essential Forms installed 
at the other computer. 

 
The export feature works by copying the information contained in the client’s matter database 
and all of the saved forms contained in that matter folder onto the portable media that you 
choose. You cannot export data by selecting the client. You must select the matter. Here’s how 
to use this feature: 

 
1. Click the Client Information tab. 

2. Open the client folder and find the matter  folder you wish to export.  You can select 
multiple matters for the same client using the standard Windows selection techniques if 
desired. 

3. Either click the selected matter(s) with your right mouse button, or select the File menu at 
the top of your screen and then select Export Matters as shown on the next page. 
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4. You will see the “Export data” window as shown below. Select the appropriate media drive 
and folder where you want to export the matter data and click on the “Save” button.

 
 

5. Now you can take the media with the exported data to your new location, where you can 
import this data into Essential Forms on another computer (as explained below). 

 
 
Importing Client Matters & Saved Forms 
 

Once you have exported your client/matter data to a portable medium you can continue working 
on it by importing it into Essential Forms on a computer at another location. Here’s how: 
 
1. Open the Essential Forms program on the computer you plan to work on. Select the File 

menu at the top menu bar. Then select Import Matter(s) from the pull-down menu, as 
shown on the next page: 
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2. You will see an Import data window as shown below. Browse to the drive or media 
containing your exported data and you will see the file name(s) of the exported matter(s). 
Select one or more matters for import and click the “Open” button. 

 

 
 

3. The client data will automatically be imported into Essential with all of its associated saved 
forms. If the copy of Essential Forms you’re importing to already has a client and matter with 
the same names, you will get a confirmation screen asking you if you want to replace the 
existing matter with the new imported matter, as shown below. Select the appropriate button. 

 

 
 

TIP   If the matter you want to import already exists under the same client and matter 
names, but contains different saved forms, you can preserve both matters and form 
sets by renaming the existing matter before importing the exported matter from the 
other copy of Essential Forms.  See pages 12-13 for details on renaming matters. 

Backing Up Your Data 
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We recommend that you develop a routine to back up your Essential Forms data in order to 
prevent the loss of your client files if you should experience a hard-drive crash. We have provided 
a simple utility to accomplish this task. This utility will back up all the data you’ve created in 
Essential Forms, including the client database and saved forms. Here is how: 
 
1. Click on File on the top menu bar and then select Backup Data from the pull-down menu. 

 
2. You will see the following dialog box pop up, asking you to insert the backup media. After 

you have inserted the media (CD, portable hard drive, USB thumb drive, etc.), or if you are 
saving your backup directly to your hard drive or a network drive, click Continue. 
 

 
 

3. Next you will see a pop-up (shown below left) asking to select your backup drive. Select the 
appropriate drive, click Continue, browse to the folder on that drive where you want your 
backup to be saved (shown below right) and click OK. 
 

 
 

4. When the data backup is finished, Essential Forms will display a pop-up window indicating 
that the backup was successful. Click OK to return to the program. 

 
TIP   You can also use the backup feature to move your entire client database to 
another computer. Just be aware that it will overwrite any existing Essential Forms 
data on that other computer. 

 
Restoring Your Data 

 
In the event that your client database is lost or corrupted due to a hard-drive crash or power 
failure, you can restore it, assuming that you have previously made a backup of those files. 

 
TIP   Essential Forms automatically makes a complete backup of your data 
whenever you run the installation program from the Judicial Council forms update 
CD or its equivalent downloadable version.  These backups are stored in your 
Essential Forms data folder in a subdirectory called Release Backups, with further 
subdirectories for each update period.  For example, the folder 1707 would contain 
a backup for each time the July 2017 update CD or download equivalent was run. 

 
You can also use the restore data utility to move your entire set of client data files from one 
computer to another. Just be aware that this utility will overwrite any data already existing in the 
data folder where the restore is done. Here is how to restore your backed-up data: 
1. From the top menu bar, click File and then select Restore Data From Backup from the pull-
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down menu. 
 

2. If Essential Forms can’t automatically locate your backup file, it will display a pop-up window 
asking you to select the drive where your backed-up data is located (as shown below left). 
Select the appropriate drive, click Continue, then browse to the appropriate folder and click 
OK (as shown below right): 
 

 
 

3. Next you will see a pop-up screen indicating that the program has located the backup data 
set and asking you if you want to restore this data set to Essential Forms. Remember that it 
will overwrite any client files that exist, so be sure this is what you want to do. You can also 
look for the backed-up data in another location. If you are unsure what to do, it is 
recommended that you call Technical Support before proceeding. Normally when using this 
utility you would want to restore the data. If you do, click Restore data. 

 
4. You will then see one more warning screen to confirm this is what you want to do. Click 

Restore data. 
 

5. The program will now restore all the data in the chosen backup file. This may take several 
minutes depending upon the number of client files you had backed up. When the program is 
finished, you will get a screen informing you that the data was successfully restored. You 
now have full use of the Essential Forms program with all of your restored clients and saved 
forms as of the date that you backed up your files.  

 
Obsolete & Revised Forms 
 

What happens to saved forms that have been revised by subsequent updates? The program 
performs several automatic processes when you install a new update. When you re-open a form 
that’s been revised by the Judicial Council or by the local Superior Court, you may experience 
one of the following: 

 
 If the saved form is still current, or if its revision did not affect its data fields, it will simply 

be loaded and displayed. 

 If the saved form is no longer valid, Essential Forms will notify you that the form is 
obsolete and it will open in read-only mode. You can read and copy text you’ve entered 
on this form to the Windows clipboard, but the form can no longer be edited. If you print 
this form it will be watermarked as “OBSOLETE” in order to prevent its accidental filing. 

 If the form is not obsolete, but the revision has added, removed, or resized its data 
fields, it is possible that the saved form’s data no longer matches the field structure of 
the revised form. In this case Essential Forms will inform you of this situation. You may 
load this form but it is likely that some of the saved data will be truncated, appear in the 
incorrect field, etc. 

 In either of the last two cases, our recommendation is to click on the Forms Library 
tab, find and open a blank copy of the form (which will be the most recent revision 
available), and re-fill the form. 

The Essential Forms Updater 
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CEB produces two Essential Forms Judicial Council forms update CDs per year, one in January 
and one in July.  Installing these updates keeps your subscription current.  In addition, if you 
subscribe to any county local forms add-on modules, you’ll receive one or more CDs which will 
add those to your installation.  If the county/ies to which you subscribe update their forms, and/or 
if the Judicial Council releases new or revised forms that take effect any other time besides 
January 1 or July 1, the Essential Forms Updater will automatically download these updated 
forms modules over the Internet to your computer and notify you when they’re ready to install.  
Here’s how it works: 

 
 Your Essential Forms subscription must be current.  If a warning is displayed when 

you launch Essential Forms that “This program contains forms out of date as of…”, 
your Essential Forms Updater cannot check for updated forms.  You’ll need to install 
a current Judicial Council forms update CD to restore your subscription to current 
status. 

 When you open Essential Forms, the Essential Forms Updater will automatically 
launch as well, running in the background.  When the Updater is running, you can 
find it in the notification area (bottom right-hand corner) of your Windows Desktop, 
as shown below (note that you may need to click “Show hidden icons” to see all the 
icons in your notification area): 
 

 
 

 Once per day, the Updater will check our server, and if any updates are available for 
your installed forms modules, it will automatically download them to your computer. 

 Once the available forms modules have been fully downloaded, the Updater and 
Essential Forms will both notify you that those updates are ready to install, as 
shown here: 

 

 
 

 
 

 To install the updated forms module(s), close Essential Forms (and if you’re using it 
on a network, have all other users close Essential Forms as well) and reopen it.  
When Essential Forms opens, it will prompt you to install the updates, as shown 
here: 

 
 

 Simply click Yes and follow the prompts to install the update(s). 
 
TIP You can close the Updater, change its settings, or force it to check for updates 
by right-clicking on the Updater icon in the notification area and selecting the 
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appropriate menu choice. 
 

TIP You can check to see which forms modules you have installed in Essential 
Forms by selecting Display Installed Modules from the View menu.  The resulting 
pop-up window will list all the forms modules currently installed on your system, 
along with the release date of each currently installed module, as shown here: 

 

 
 

System Requirements 

                Computer/Operating System 
Any personal computer running:  
Windows  7, 8, 8.1, or 10 
(Pentium level recommended) 

Printer Any Windows-compatible printer 
Disk Space 300MB available space on hard drive 
Network? Each copy of Essential Forms is shipped ready to run on a network or 

as a stand-alone application. Note that with a shared database, by 
default a customer subscription provides access to the data by only one 
user at a time. Should you desire more users to be able to access 
shared data simultaneously on your network, please contact CEB 
Customer Service at 1-800-232-3444 to purchase a 5, 10, 20, 25, 50, 
75 or 100-user “Netpack” upgrade. 

 
 

How To Contact Us 

Still have questions? Check out our online FAQ’s and start a live chat with a 
member of our Tech Support team - just click the       chat icon on the bottom-right 
of the FAQ page.   

 
Technical Support: (800) 870-1101 
Monday-Friday 9:00 a.m.-5:00 p.m. PT 
E-mail: tech_support@ceb.ucla.edu 

 
 

Sales/Customer Service: (800) 232-3444 
Monday-Friday 7:30 a.m. -5:00 p.m. PT 
E-mail: customer_service@ceb.ucla.edu 
 

On the Web:  www.ceb.com 

http://help.ceb.com/en/collections/2482118-essential-forms
mailto:tech_support@ceb.ucla.edu
mailto:customer_service@ceb.ucla.edu
http://www.ceb.com/
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